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Introduction and Overview

Welcome to TeachUcomp Inc.’s Mastering PowerPoint

Made Easy™ tutorial. PowerPoint is a multimedia program

designed to create and display presentations. A

presentation is a collection of slides that you show to a

group. A slide is a screen that can contain any content that

you wish. They are like old photographic slides, but with

much more power and flexibility in their design.

This tutorial starts by taking a new PowerPoint user

through the process of creating their first presentation. You

learn the basic skills that make creating a basic PowerPoint

presentation quick and easy. You also learn about

presentation file management so you can open, create,

save, modify, and display your presentation to others.

The tutorial then shows material to help enhance the

skill set of a user who can already create basic

presentations with text and pictures. In this part of the

tutorial, you learn how to apply animation. You also learn

how to insert multimedia files, shapes, tables and other

types of more advanced objects into slides

The overall purpose of the Mastering PowerPoint Made

Easy™ tutorial is to give you the talents and skills

necessary to create impressive presentations that allow

you to fully control the expression of your ideas and your

creativity using PowerPoint.
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Getting Acquainted with PowerPoint

1.1- The PowerPoint Environment:

The picture shown is the initial screen that appears when you create a new blank presentation in

PowerPoint 2019 or 365. This presentation view is called “Normal” view and it is the default view of a new

presentation in PowerPoint. However, it is only one of many possible presentation views. This is the view in

which you spend most of your time when creating a presentation.

A presentation is the default type of file in PowerPoint. You create and edit individual slides within a

presentation file in PowerPoint. The presentation slides contain many text and graphic objects which show

the presentation’s contents. When you close a presentation, PowerPoint prompts you to save unsaved

changes in the presentation, if needed.

The following lessons of this chapter examine the elements of the PowerPoint environment. New

PowerPoint users should first familiarize themselves with the many tools and elements of the program’s

environment before creating a presentation.

The presentation slides appear in the center pane of the “Normal” presentation view in the

application window. The application window consists of the Title Bar, the Ribbon, the Status Bar, and the

presentation slides. The most important tool is the Ribbon at the top of the application window. The Ribbon

is where you find the tabs, button groups, buttons, and commands in PowerPoint. The “File” tab allows you

access to the Backstage view. In the Backstage view, you find common file management commands, like

creating a new presentation, saving a presentation, PowerPoint’s default options, and printing options.

Status Bar

The 

Ribbon

Title Bar

Presentation View

Buttons

Slide

Slide 

Thumbnails

Pane

Zoom Slider

The Quick Access Toolbar

PowerPoint 

Designer Pane

Notes 

Pane
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Getting Acquainted with PowerPoint

1.1- The PowerPoint Environment- (cont'd.):

Above the Ribbon is the Title Bar, which shows the title of the current presentation file towards its

center. At the left end of the Title Bar is the Quick Access Toolbar. You can easily add buttons to this

toolbar for the commands you use most frequently and always want available. The “AutoSave,” if saving

files to OneDrive or SharePoint, “Save,” “Undo,” “Redo” and “Customize Quick Access Toolbar” buttons

appear here, by default. However, note that the “AutoSave” button is for Microsoft 365 subscribers only.

You can also easily remove buttons you add to this toolbar, as we will discuss in a later lesson.

The current presentation slide appears below the Ribbon in the center slide pane. This is where you

create the content of the presentation slides. Most of the work in PowerPoint is accomplished in this area.

As you create the presentation’s slides, slide thumbnails appear in the slide thumbnails pane at the left side

of the Normal view. This pane also will show a vertical scroll bar after you add multiple slides that you can

use to scroll through the thumbnails, if needed. You can click a thumbnail in this pane to display its content

in the slide pane to its right.

You can click the “Notes” button towards the right end of the status bar, next to the presentation

view buttons, to show or hide the Notes pane. Although no longer appearing by default, the notes pane

below the current slide lets you click into it to type presenter notes for the slide, if needed.

For Microsoft 365 subscribers, you will also see a “Design Ideas” pane from the PowerPoint

Designer service that shows design ideas for the current slide in a pane at the right side of this view. You

can click a design idea in the PowerPoint Designer pane to apply it to the current slide.

After you create multiple slides, then a vertical scroll bar appears at the far-right side of the

presentation. You may also see a horizontal scroll bar at the bottom of a presentation if it is very wide or if

you zoom in on the current slide. You use the vertical scroll bar to scroll up and down through the

presentation’s slides. You can use the horizontal scroll bar, if shown, to scroll left and right across a

presentation slide.

You can easily zoom in to increase the slide magnification or zoom out to decrease the slide

magnification using the Zoom slider within the Status Bar in the lower-right corner of the window. If your

mouse has a scroll wheel, you can also press and hold the “Ctrl” key on your keyboard and scroll up with

the scroll wheel to zoom in or scroll down to zoom out. The various presentation view buttons appear to the

left of the zoom slider in the Status Bar. These buttons let you switch the presentation view, as needed.

Now that we have an overview of the major onscreen elements, where they appear by default, and

what they are called, we can now look at the general use and functionality of the various onscreen elements

within the PowerPoint application.

1.2- The Title Bar:

The Title Bar is the bar that runs across the top of the application window. The name of the

presentation on which you are working appears towards the center of this bar. In PowerPoint for Microsoft

365, the Microsoft Search Bar may also appear here. At the right end of the Title Bar is a button group.

There are four buttons in this group. They are, from left to right, “Ribbon Display Options,” “Minimize,”

“Maximize/Restore Down,” and “Close.”

Clicking the “Ribbon Display Options” button shows you options for changing the Ribbon’s display in

a drop-down menu. You can click the choice of Ribbon display you prefer in this drop-down menu.

Clicking the “Minimize” button sends the application window down to the Windows Taskbar. You can

view it again later by clicking its entry within the Windows Taskbar. Clicking the “Maximize” button enlarges

the application window to fill the entire display. It also toggles the function of the same button to the
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Getting Acquainted with PowerPoint

1.2- The Title Bar- (cont'd.):

“Restore Down” command. Clicking the “Restore Down” button changes the size of the window, letting you

size and position it onscreen by using your mouse. When you click the “Restore Down” button, it then

toggles back into the “Maximize” button. Clicking the “Close” button closes PowerPoint. If you have unsaved

changes in any presentations, you are prompted to save those changes before the program closes.

1.3- The Ribbon:

The primary tool you use in PowerPoint is the Ribbon. This object lets you perform all the commands

available in the program. The Ribbon is divided into tabs. Within these tabs are different groups of

commands. You can access the commands in each button group by using either the buttons, boxes, or

menus available in the button group.

To access advanced options for some button groups, you can click the “dialog box” launcher button

in the lower-right corner of some button groups on the currently displayed, or “active,” tab in the Ribbon.

Doing this then opens a dialog box of all the available options or settings for the button group.

Also notice that you can double-click the active tab in the Ribbon to both hide and show the

contents of the Ribbon. This can be a handy way to gain additional workspace while creating your

presentation’s contents. You can click the main tabs in the Ribbon to switch the button groups that appear.

The default tabs that appear in the Ribbon are: “File,” “Home,” “Insert,” “Draw” (If using Microsoft 365)

“Design,” “Transitions,” “Animations,” “Slide Show,” “Review,” “View,” “Recording,” and “Help.” You can also

enable the “Developer” tab, if using macros or code within a presentation.

In addition to PowerPoint’s primary tabs, special contextual tabs also appear in the Ribbon after

selecting some types of slide objects. Contextual tabs appear, for example, after selecting a picture, table,

diagram, drawing, or chart. The button groups on the contextual tabs let you modify the selected type of

object. To hide the contextual tabs, click away from the selected slide object to deselect it. In older versions

of Microsoft Office, these tabs often appear in a separate row of the Ribbon with sub-tabs below them. In

newer Microsoft Office versions, they appear as colored tab names to the right of the primary tabs in the

Ribbon. Their names also slightly change between versions, too.

1.4- The “File” Tab and Backstage View:

Unlike other primary tabs in the Ribbon, clicking the “File” tab in the Ribbon opens a view of the file

called the Backstage view. This view lets you perform all your file management. This includes functions like

saving a file, opening an existing file, and creating a new file.

When you click the “File” tab in the Ribbon, you no longer see the file’s contents. Instead, the file’s

Backstage view appears. The commands at the left side of the Backstage view are the available file

management commands, followed by account and program options in a separate command section.

Clicking a command in the list of file management commands at the left side of the Backstage view

then shows additional options for the selected command to the right. You can then make additional

selections in the new section, as needed. For example, to create a new presentation, click the “New”

command at the left side of the Backstage view. Then select the desired template from which to create the

new presentation from the template listing to the right in the Backstage view. After completing a command

in the Backstage view, you then often return to the normal working view of the presentation. However, if you

enter the Backstage view and want to exit without selecting a command, click the “Back” arrow button in the

upper-left corner of the Backstage view to return to the normal file view.
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Getting Acquainted with PowerPoint

1.5- The Quick Access Toolbar:

The Quick Access toolbar appears above the Ribbon, by default. To place it below the Ribbon, if

desired, click the “Customize Quick Access Toolbar” button at the right end of the toolbar. Then select the

“Show Below the Ribbon” command from the drop-down menu that appears. To reset it to its default

location, click the same “Customize Quick Access Toolbar” button. Then choose the “Show Above the

Ribbon” command from the drop-down menu that appears.

This is the only toolbar available in PowerPoint. By default, you have buttons for quick access to the

following commands: “AutoSave,” if saving files to OneDrive or SharePoint, “Save,” “Undo,” and “Redo

(Repeat).” However, you can also easily add buttons to this toolbar for the functions you use most.

One way to add a button to the Quick Access toolbar is to right-click the command button or function

in the Ribbon to add. Then choose the “Add to Quick Access Toolbar” command from the pop-up menu that

appears. To remove a button from the Quick Access toolbar, right-click the button to remove in the Quick

Access toolbar. Then select the “Remove from Quick Access Toolbar” command from the pop-up menu.

To more thoroughly customize the Quick Access toolbar, click the “Customize Quick Access

Toolbar” button. Then click the “More Commands…” choice to open the “PowerPoint Options” dialog box.

The right side of the dialog box contains two sets of command button listings. The listing at its far-right side

is the current set of button commands in the Quick Access toolbar. The order the commands appear in this

list from top to bottom is the order they appear from left to right in the Quick Access toolbar.

To the left of this list is the listing of commands you can add to the Quick Access toolbar. You can

select which functions appear in this list by selecting a command grouping to show from the “Choose

commands from:” drop-down above the list.

To add a command to the Quick Access toolbar from this list, click the command to add from the

choices available in the left list. Then click the “Add>>” button to move the selected command into the Quick

Access toolbar list to the right. To remove a command from the Quick Access toolbar list at the right, click it

to select it, first. Then click the “Remove” button to remove it from the list.

To change the order in which the buttons appear in the Quick Access toolbar, first select a command

in the right-most list. Then click either the “Up” or “Down” arrow buttons to the right of this list. After

customizing the content of the Quick Access Toolbar, click the “OK” button in the lower-right corner of the

“PowerPoint Options” dialog box to save and apply your changes.

1.6- Touch/Mouse Mode:

Because of the increased use of tablets, PowerPoint contains a mode that gives you easier access

to the buttons and commands in the Ribbon and Quick Access toolbar. This mode is called touch mode.

When you enter touch mode in PowerPoint, you enlarge the Ribbon and Quick Access toolbar. You also

add extra space around the buttons and commands in the Ribbon and Quick Access toolbar. These

changes let you more easily access these buttons on a touch-based tablet.

To enable touch mode, click the small drop-down arrow at the right end of the Quick Access toolbar

to display a drop-down menu of the most commonly-used commands. Click or tap the “Touch/Mouse Mode”

command in the drop-down menu to add that button to the Quick Access toolbar.

To then enable or disable touch mode in PowerPoint, click or tap the “Touch/Mouse Mode” button in

the Quick Access toolbar. From the drop-down menu that then appears, select the mode to use: “Mouse” or

“Touch.” When “Touch” mode is enabled, the buttons in the Ribbon and Quick Access toolbar are larger

and have more space surrounding them onscreen. You can select the “Mouse” choice to toggle touch mode

off, restoring the default size of the buttons onscreen.
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Getting Acquainted with PowerPoint

1.7- The Scroll Bars:

Depending the number of slides added to the presentation and the current slide’s magnification

level, scroll bars may appear at the right side of the slide thumbnails pane and both vertically and

horizontally along the right and bottom sides of the current presentation slide. You use the scroll bars to

scroll through the presentation’s content.

The scroll bars have arrow buttons at each end that point in the direction in which they will scroll the

slide when you click them. You may click the arrows at the ends of the scroll bars to move through the

content or click and drag the box inside the scroll bars to move more rapidly. If you have a mouse with a

scroll wheel, you can simply roll the scroll wheel on your mouse up or down to vertically scroll through the

presentation’s slides, as the scroll wheel on your mouse is typically set to work with the vertical scroll bar.

For presentations with multiple slides, also note the set of double-pointing up and down arrows at

the bottom of the vertical scroll bar. You can click these two buttons to move to the “Previous Slide” or “Next

Slide” in your presentation.

1.8- The Presentation View Buttons:

When working on a PowerPoint presentation, you may find you are frequently switching presentation

views. To change the presentation view in PowerPoint, click a presentation view button in the lower-right

corner of the screen. The buttons are “Normal,” “Slide Sorter,” “Reading View” and “Slide Show.”

Alternatively, to change the presentation view in PowerPoint, click the “View” tab in the Ribbon. Then click

the desired presentation view button in the “Presentation Views” button group.

When you create a new presentation in PowerPoint, the new presentation opens in “Normal” view.

In “Normal” view, the left side of the presentation shows a slide thumbnails pane for easy access to slides.

There is also a pane at the bottom of the slide you can use to access its presenter’s notes. To show or hide

the Notes pane in Normal view in PowerPoint, click the “Notes” button towards the right end of the Status

Bar. We will examine each of these different views in later chapters.

1.9- The Zoom Slider:

The Zoom slider in PowerPoint appears in the lower-right corner of the application window in the

Status Bar. You use this tool to change the magnification level of the slide. This does not modify the slide at

all, but only changes your perception of how close or far away it appears onscreen.

You can easily change the magnification level by using the Zoom slider. Click and drag the slider left

towards the minus symbol (-) to shrink the magnification level. The magnification level appears as a

percentage to the right of the zoom slider. You can click and drag the slider to the right, or towards the plus

sign (+), to increase the magnification level.

If you increase the slide magnification to the point that it can no longer fully appear onscreen

horizontally, the horizontal scroll bar then appears below the slide. You can then use it to scroll left and right

to fully inspect the slide at your desired magnification level. Clicking directly on either the plus or minus sign

also increases or decreases the slide’s magnification level.

To reset the slide to fit within the available slide area in the view, click the “Fit slide to current

window” button to the right of the Zoom slider. Alternatively, click the “View” tab in the Ribbon. Then click

the “Fit to Window” button in the “Zoom” button group in the Ribbon.

You can also change the slide magnification in PowerPoint by using the “Zoom” dialog box. To open

the “Zoom” dialog box in PowerPoint, click the actual zoom magnification level, shown as a percentage in
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Getting Acquainted with PowerPoint

1.9- The Zoom Slider- (cont’d.):

the Status Bar. Alternatively, click the “View” tab in the Ribbon. Then click the “Zoom” button in the “Zoom”

button group. In the “Zoom” dialog box, select the desired zoom level by choosing an option from the “Zoom

to” section or by entering a value into the “Percent:” spinner. After setting the desired magnification level,

click the “OK” button to apply it.

1.10- The Status Bar:

The Status Bar in PowerPoint appears at the bottom of the application window as a long, thin,

horizontal bar in which you find objects such as the Zoom slider and the presentation view buttons. The

Status Bar shows the various statuses monitored in PowerPoint, like the magnification level, the current

slide number, and total count of slides. You can choose which statuses to show or hide in the Status Bar.

To see which statuses are currently shown or hidden in the Status Bar in PowerPoint, right-click

anywhere in the Status Bar to show the “Customize Status Bar” panel. This panel is a listing of the available

tools and statuses you can show or hide in the Status Bar. Any listed objects that appear with a check to the

left of their names already appear in the Status Bar. Objects without a check to the left of their names in this

list do not appear in the Status Bar. You can click the name of any object in this list to toggle its display in

the Status Bar on or off, as desired.

1.11- The Mini Toolbar:

Another useful and time-saving feature in Microsoft PowerPoint is the Mini toolbar. When you select

text within a presentation and hold your mouse pointer over it, a small dimmed-out toolbar then appears

next to the text selection. You can roll your mouse pointer over the faded-out toolbar to make it appear

solid. You can then select from the many text formatting buttons that appear in the Mini toolbar to apply

quick formatting to the selected text.

1.12- Keyboard Shortcuts:

If you are new to PowerPoint, then you may be wondering what a “keyboard shortcut” is. A keyboard

shortcut lets you press a combination of keyboard characters to execute a command instead of clicking a

button in the Ribbon or the Quick Access Toolbar. While you may never really use them, many users who

type significant amounts of text find it tiresome to always reach for their mouse. These users may favor the

use of keyboard shortcuts, instead, as it lets them perform many commands while keeping their hands on

the keyboard.

Keyboard shortcuts typically involve holding down either the “Ctrl” or “Alt” key on your keyboard and

then entering another keystroke or set of keystrokes. Then release the “Ctrl” or “Alt” key. You can see any

available “Ctrl”-key keyboard shortcuts in the small pop-up windows that appear when you hold your mouse

pointer over any command function in the Ribbon. These are called “screentips” in PowerPoint. However,

not every command function has a corresponding “Ctrl”-key keyboard shortcut. In these cases, you can use

the “Alt” key to enable the key badge system in PowerPoint. You can then use the key badge system to

enter a sequence of keystrokes. Let’s look at how to use the key badge system in PowerPoint.

First, press the “Alt” key on your keyboard to show a set of key badges next to the objects in the

Ribbon and Quick Access toolbar. Then press the key on your keyboard that corresponds to the command
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Getting Acquainted with PowerPoint

1.12- Keyboard Shortcuts- (cont’d.):

function to show or execute. Continue pressing the corresponding key badges that appear until you press

the key badge for the final command function to execute.

If you happen upon a drop-down menu when entering key badges or your key badge work opens a

dialog box, don’t worry. You can execute a command in a dialog box or in a drop-down by looking to see if

the command function to execute has an underlined letter in its name. If it does, press the key on your

keyboard that corresponds to the underlined letter. That is the same thing as pressing a corresponding

keyboard key when you see a key badge. You can also use the arrow keys on your keyboard to change the

highlighted selection in many drop-down menus. Then press the “Enter” key on your keyboard to accept the

highlighted choice.
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ACTIONS-

Getting Acquainted with PowerPoint
THE POWERPOINT ENVIRONMENT:

1. The default view for a new PowerPoint presentation is the “Normal” presentation view.

2. The presentation slides appear in the center pane of the “Normal” presentation view in the application

window.

3. The application window consists of the Title Bar, the Ribbon, the Status Bar, and the presentation

slides.

4. The most important tool is the Ribbon at the top of the application window. The Ribbon is where you

find the tabs, button groups, buttons, and commands in PowerPoint.

5. The “File” tab of the Ribbon allows you access to the Backstage view. In the Backstage view, you find

common file management commands.

6. Above the Ribbon is the Title Bar, which shows the title of the current presentation file.

7. At the left end of the Title Bar is the Quick Access Toolbar. You can easily add buttons to this toolbar

for the commands you use most frequently and always want available.

8. The current presentation slide appears below the Ribbon in the center slide pane. This is where you

create the content of the presentation slides.

9. As you create the presentation’s slides, slide thumbnails appear in the slide thumbnails pane at the

left side of the Normal view. You can click a thumbnail in this pane to display its content in the slide

pane to its right.

10. You can click the “Notes” button towards the right end of the status bar, next to the presentation view

buttons, to show or hide the Notes pane.

11. For Microsoft 365 subscribers, you will also see a “Design Ideas” pane from the PowerPoint Designer

service that shows design ideas for the current slide in a pane at the right side of this view. You can

click a design idea in the PowerPoint Designer pane to apply it to the current slide.

12. After you create multiple slides, then a vertical scroll bar appears at the far-right side of the presentation.

You may also see a horizontal scroll bar at the bottom of a presentation if it is very wide or if you zoom

in on the current slide. You use the vertical scroll bar to scroll up and down through the presentation’s

slides. You can use the horizontal scroll bar, if shown, to scroll left and right across a presentation slide.

13. You can easily zoom in to increase the slide magnification or zoom out to decrease the slide

magnification using the Zoom slider within the Status Bar in the lower-right corner of the window.

14. The various presentation view buttons appear to the left of the zoom slider in the Status Bar. These

buttons let you switch the presentation view, as needed.

THE TITLE BAR:

1. To adjust the size of the application window, use the buttons on the right side of the Title Bar.

2. To minimize the application window, click the “Minimize” button.

3. You can view it again later by clicking its entry within the Windows Taskbar.

4. To maximize the application window, click the “Maximize / Restore Down” button. When the

application window is maximized, it will fill the screen of your monitor.

5. To return the window to its previous position after being maximized, click the “Maximize/Restore

Down” button again.

6. To close the application window, click the “Close” button. If you have unsaved changes in any open

documents, you are then prompted to save those changes before the program closes.
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ACTIONS-

Getting Acquainted with PowerPoint
THE RIBBON:

1. The Ribbon contains different tabs of command buttons you need to create a presentation contained in

button groups on the tabs.

2. To access advanced options for some button groups, click the “dialog box” launcher button in the

lower-right corner of some button groups on the currently displayed, or “active,” tab in the Ribbon.

3. To show or hide the contents of the Ribbon, double-click the active tab.

4. To switch active tabs, click on the name of any other tab in the Ribbon.

5. To see the special contextual tabs in PowerPoint, select a picture, table, diagram, drawing or chart

in your presentation slide.

6. To close a contextual tab in PowerPoint, click away from the selected object.

THE “FILE” TAB AND BACKSTAGE VIEW:

1. To open the Backstage view to perform file management functions in PowerPoint, click the “File”

tab in the Ribbon.

2. The commands that appear at the left side of the Backstage view are the available file management

commands, followed by account and program options in a separate command section

3. Clicking a command in this list of file management commands at the left side of the Backstage view then

shows additional options for the selected command to the right in the Backstage view.

4. You can then make additional selections in the new section, as needed.

5. After completing a command in the Backstage view, you will then often return to the normal working

view of the presentation.

6. However, if you enter the Backstage view and want to exit without selecting a command, click the

“Back” arrow button in the upper-left corner of the Backstage view to return to the normal presentation

view.

THE QUICK ACCESS TOOLBAR:

1. To move the Quick Access Toolbar below the Ribbon, click the “Customize Quick Access Toolbar”

button in the Quick Access Toolbar.

2. Then choose the “Show Below the Ribbon” command.

3. To move the Quick Access Toolbar back above the Ribbon, click the “Customize Quick Access

Toolbar” button in the Quick Access Toolbar.

4. Then choose the “Show Above the Ribbon” command.

5. To add a button to the Quick Access Toolbar, right-click the function or command button in the

Ribbon and choose the “Add to Quick Access Toolbar” command from the pop-up menu that appears.

6. To remove a button from the Quick Access Toolbar, right-click the button in the Quick Access

Toolbar and choose “Remove from Quick Access Toolbar” from the menu that appears.

7. To more thoroughly customize the Quick Access Toolbar, click the “Customize Quick Access

Toolbar” button and choose the “More Commands…” option from the menu.

8. The “PowerPoint Options” dialog box appears with the “Quick Access Toolbar” section selected. The

options for customizing the Quick Access Toolbar appear to the right.

9. To add a command to the Quick Access Toolbar in the “PowerPoint Options” dialog box, select a

command to add from the list on the left.

(cont’d.)
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ACTIONS-

Getting Acquainted with PowerPoint
THE QUICK ACCESS TOOLBAR- (CONT’D.):

10. If needed, choose the commands to show in this list by using the “Choose commands from:” drop-down

above the list.

11. Then click the “Add>>” button to add the selected command to the right list. This list shows the

commands currently displayed in the Quick Access Toolbar.

12. To remove a command from the Quick Access Toolbar by using the “PowerPoint Options”

dialog box, click the name of the command in the right list to remove.

13. Click the “Remove” button to remove it from the list.

14. To change the order of the commands in the Quick Access Toolbar, select the command to move

in the right list and then click the “Up” or “Down” arrow buttons to its right. The order of the commands

from top to bottom is the order they appear from left to right in the Quick Access Toolbar.

15. To save the changes you made in the “PowerPoint Options” dialog box, click the “OK” button in

the lower-right corner.

TOUCH/MOUSE MODE:

1. To enable touch mode in PowerPoint, click the small drop-down arrow at the right end of the Quick

Access toolbar to display a drop-down menu of the most commonly-used commands.

2. Click or tap the “Touch/Mouse Mode” command in the drop-down menu to add that button to the Quick

Access toolbar.

3. To then enable or disable touch mode in PowerPoint, click or tap the “Touch/Mouse Mode” button in

the Quick Access toolbar.

4. From the drop-down menu that then appears, select the mode to use: “Mouse” or “Touch.”

5. When “Touch” mode is enabled, the buttons in the Ribbon and Quick Access toolbar are larger and

have more space surrounding them onscreen.

6. You can select the “Mouse” choice to toggle touch mode off, restoring the default size of the buttons

onscreen.

THE SCROLL BARS:

1. Depending the number of slides added to the presentation and the current slide’s magnification level,

scroll bars may appear at the right side of the slide thumbnails pane and both vertically and horizontally

along the right and bottom sides of the current presentation slide.

2. You use the scroll bars to scroll through the presentation’s content.

3. To use the scroll bars to scroll through your presentation’s content, click the arrows at the ends of

the scroll bars to move through the presentation in that direction.

4. Alternatively, click and drag the box inside of the scroll bars to rapidly move through the presentation.

5. If you have a mouse with a scrolling wheel, you can simply roll the scroll wheel on your mouse up or

down to vertically scroll through your presentation’s content.

6. For presentations with multiple slides, also note the set of double-pointing up and down arrows at the

bottom of the vertical scroll bar. You can click these two buttons to move to the “Previous Slide” or “Next

Slide” in your presentation.
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ACTIONS-

Getting Acquainted with PowerPoint
THE PRESENTATION VIEW BUTTONS:

1. To change the presentation view in PowerPoint, click a presentation view button in the lower-right

corner of the screen. The buttons are “Normal,” “Slide Sorter,” “Reading View” and “Slide Show.”

2. Alternatively, to change the presentation view in PowerPoint, click the “View” tab in the Ribbon.

3. Then click the desired presentation view button in the “Presentation Views” button group.

4. When you create a new presentation in PowerPoint, the new presentation opens in “Normal” view.

5. In “Normal” view, the left side of the presentation shows a slide thumbnails pane.

6. There is also a pane at the bottom of the slide you can use to access its presenter’s notes.

7. To show or hide the Notes pane in Normal view in PowerPoint, click the “Notes” button towards the

right end of the Status Bar.

THE ZOOM SLIDER:

1. To zoom in or out of your presentation by using the Zoom slider, click and drag the slider.

2. To shrink the magnification, click and drag to the left, towards the minus sign (-).

3. To increase the magnification, click and drag to the right, towards the plus sign (+).

4. Alternatively, directly click the minus or plus sign to shrink or increase the magnification.

5. To reset the slide to fit within the available slide area in the view, click the “Fit slide to current

window” button to the right of the Zoom slider.

6. Alternatively, click the “View” tab in the Ribbon and then click the “Fit to Window” button in the “Zoom”

button group in the Ribbon.

7. To change the slide magnification in PowerPoint by using the “Zoom” dialog box, open the

“Zoom” dialog box in PowerPoint by clicking the actual zoom magnification level, shown as a

percentage in the Status Bar.

8. Alternatively, click the “View” tab in the Ribbon and then click the “Zoom” button in the “Zoom” button

group.

9. In the “Zoom” dialog box, select the desired zoom level by choosing an option from the “Zoom to”

section or by entering a value into the “Percent:” spinner.

10. After setting the desired magnification level, click the “OK” button to apply it.

THE STATUS BAR:

1. The Status Bar in PowerPoint appears at the bottom of the application window as a long, thin, horizontal

bar in which you find objects such as the Zoom slider and the presentation view buttons.

2. To see which statuses are currently shown or hidden in the Status Bar in PowerPoint, right-click

anywhere in the Status Bar to show the “Customize Status Bar” panel.

3. This panel is a listing of the available tools and statuses you can show or hide in the Status Bar.

4. Any listed objects that appear with a check to the left of their names already appear in the Status Bar.

5. Objects without a check to the left of their names in this list do not appear in the Status Bar.

6. You can click the name of any object in this list to toggle its display in the Status Bar on or off, as

desired.
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ACTIONS-

Getting Acquainted with PowerPoint
THE MINI TOOLBAR:

1. To use the Mini toolbar in PowerPoint, select text within a presentation and hold your mouse pointer

over it to show a small dimmed-out toolbar appear next to the text selection.

2. Then roll your mouse pointer over the faded-out toolbar to make it appear solid.

3. Then select from the many text formatting buttons that appear in the Mini toolbar to apply quick

formatting to the selected text.

KEYBOARD SHORTCUTS:

1. To enter a keyboard shortcut that begins with the “Ctrl” key, press and hold down the “Ctrl” key.

2. Then simultaneously press any other keys listed in the “Ctrl” key shortcut once.

3. Then release the “Ctrl” key.

4. To enable the key tip badges, press the “Alt” key.

5. Press the key on your keyboard that corresponds to the key tip badge that you wish to show or execute.

6. Continue pressing the corresponding key tip badge until reaching the final command to execute.

7. If you see a command in a drop-down or dialog box that has an underlined letter in its name

while using the key badge system, you can press the corresponding key for the underlined letter on

your keyboard to execute it, just as if the underlined letter were a key tip badge.

8. You can also use the arrow keys on your keyboard to change the highlighted selection in many drop-

down menus and then press the “Enter” key on your keyboard to accept the highlighted choice.
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EXERCISES-

Getting Acquainted with PowerPoint
Purpose:

To find the basic objects in the PowerPoint environment

Exercises:

1. Open your PowerPoint application.

2. Find the Zoom Slider.

3. Find the Quick Access toolbar.

4. Find the Ribbon.

5. Locate the Status Bar at the bottom of the screen and find the “Normal” presentation view button within

it towards its right end.

6. Exit the PowerPoint application.
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